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1. Ce inseamna CAD?
Acronimul CAD vine de la expresia din limba engleza Computer Aided Design (proiectare asistata de calculator). In 

momentul de fata exista pe piata un numar foarte mare de programe dedicate pentru CAD (exemplele de mai jos 

prezinta doar cateva astfel de programe).

Catia V5

NX

Solidworks

PTC Creo
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2. Importanta programelor CAD in ingineria mecanica
- Utilizarea lor duc la cresterea productivitatii si scaderea timpului necesar proiectarii unui produs nou sau 

modificarii unui produs existent;

- Cresterea calitatii design-ului;

- Faciliteaza mentinerea trasabilitatii documentelor;

- Faciliteaza comunicarea in cadrul proiectelor interdisciplinare.

3. Integrarea CAD in contextual CAx (computer aided technologies)

CAD

CAE (computer 

aided engineering)

FEA (finite 

element analysis

CFD 

(computational 

fluid dynamics)

MBD (multibody 

dynamics)

Process 

Simulation 

(casting, molding, 

die press forming)

Optimization tools

CAM (computer aided manufacturing)

PDM (Product data 

management)
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4. Legatura programelor CAD cu alte discipline
4.1 Calcule de tolerante

Exemplul din poze este realizat in programul CETOL, ce vine ca

un add-on la programele CAD. Acesta permite realizarea unor

legaturi intre diverse elemente a unei piese si intre piesele dintr-

un ansamblu astfel permitand calculul lanturilor de dimensiuni.
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4.2 Desen tehnic

Detalii referitoare la acest punct vor fi acoperite in detaliu in cadrul cursului.

4.3 Rezistenta materialelor, mecanica corpului rigid, mecanica fluidelor

Cele doua exemple prezinta rezultatele unor analize FEA si CFD. Dupa cum se poate vedea pentru obtinerea unor astfel de

rezultate este necesara realizarea in prealabil a unui model CAD.
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5. Prezentare generala a programului CATIA V5
5.1 Interfata de baza

Meniul principal

Start (accesare 

workbench-uri)

Zone dedicate toolbar-uri 

specifice fiecarui workbench

Zona grafica 

de lucru
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5.2 Schimbarea setarilor de program

Prin accesarea meniul Tools->Options se 

pot face diverse setari de program

Fereastra Options
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Schimbarea unitatilor de masura ->Tools->Options->General 

->Parameters and Measure->Units

Schimbarea preciziei grafice->Tools->Options->General 

->Display->Performance
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Schimbarea dimensiunii sistemului de coordonate->Tools    

->Options->Infrastructure->Part Infrastructure->Display 

->Axis system display size

Modul de afisare al parametrilor->Tools->Options       

->General->Parameters and Measure->Knowledge  

->Parameters Tree View
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Modificarea proprietatilor de autosave->Tools->Options      

->General->General

Modificarea surselor de lumina->View->Lighting
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5.3 Tipuri de fisiere utilizate Prin meniului Start se pot accesa workbench-urile programului

CATIA V5. Numarul acestor workbench-uri si modul in care sunt

prezentate depinde de licentele disponibile in cadrul programului.

In functie de workbench-ul utilizat programul CATIA V5 va lucra cu

diverse tipuri de fisiere ce difera ca extensie.

Extensii de fisiere native CATIA V5 intalnite in timpul cursului:

.CATPart -> extensia fisierelor ce definesc o piesa individuala;

.CATProduct -> extensie utilizata pentru ansamble;

.CATDrawing -> extensie utilizata pentru desene tehnice.

Acestea nu sunt singurele fiserele native CATIA V5 insa in cadrul

acestui curs ne vom rezuma doar la acestea.

Extensii de fisiere neutre utilizate frecvent (prin salvarea unei

piese intr-un format neutru aceasta va pastra detaliile geometrice

insa nu va mai avea istoric de creere):

.stp -> un format neutru utilizat pentru piese individuale sau

ansamble (in general defineste volume solide) ce poate fi deschis

de orice program CAD indiferent de versiune;

.igs -> un format neutru utilizat pentru piese individuale sau

ansamble (in general defineste suprafete) ce poate fi deschis de

orice program CAD indiferent de versiune;

.dxf -> un format neutru pentru desene.
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5.4 Accesarea workbench-urilor

Workbench-uri ce vor fi utilizate in

cadrul acestui curs:

Mechanical design

- Part Design -> utilizat la realizarea

volumelor solide

- Assembly Design -> utilizat la 

realizarea ansamblelor

- Drafting -> utilizat la realizarea

desenelor tehnice

- Generative Sheetmetal Design -> 

utilizat la realizarea pieselor

prelucrate prin indoire si ambutisare

Shape

- Generative Shape Design ->

utilizat la realizarea si modificarea

suprafetelor

ATENTIE! In cadrul aceluiasi fisier .CATPart sau .CATProduct (unei piese create sau ansamblu alcatuit din mai multe piese)

workbench-urile pot fi schimbate oricand. Acest lucru permite utilizarea diferitelor tool-uri disponibile in workbench-uri

diferite in cadrul aceleiasi piese.
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5.5 Crearea unei piese noi
Exista doua metode de a crea o piesa noua. In prima metoda se acceseaza meniul File->New, prin aceasta se va deschide o

noua fereastra in care trebuie selectat ce tip de fisier dorim sa cream. Pentru moment vom considera doar optiunea Part ->Ok.

Alte optiuni (Product, Drawing) vor fi considerate in a doua partea a acestui curs. Cea de-a doua metoda este mai directa in sensul

ca ne permite crearea unui anumit tip de fisier prin accesarea unui workbench (pentru o piesa noua se acceseaza workbench-urile

Part Design, Generative Sheetmetal Design sau Generative Shape Design, pentru un ansamblu nou Assembly Design,

pentru un desen nou Drafting). Atentie! Cea de-a doua metoda necesita ca nici un alt fisier sa fie deja deschis (daca un fisier este

deja deschis atunci doar se va schimba workbench-ul in cadrul aceluiasi fisier si nu se va creea unul nou). Urmand ambele

metode se va deschide o fereastra care ne va cere sa dam un nume fisierului creat.

Prima metoda de creare a unei piese noi Cea de-a doua metoda de 

creare a unei piese noi Nume Piesa (valabil si

pentru ansamble, insa

nu e valabil la accesarea

workbench-ului Drafting)
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6. Interfata workbench-ului Part Design
6.1 Gasirea si aranjarea icoanelor

O problema mare intalnita de persoanele fara experienta in lucrul cu CATIA V5, atunci cand deschid programul pentru prima data,

o reprezinta negasirea icoanelor ce definesc diverse tool-uri din fiecare workbench. Pentru rezolvarea acestei probleme exista

doua situatii: icoanele sunt “ingramadite” in fereastra sau diverse toolbar-uri nu sunt active. In general cand deschideti pentru

prima data programul va puteti astepta ca workbench-ul Part Design sa arate asemanator cu imaginea de mai jos.

Zone in care se gasesc toolbar-uri
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Existenta unor toolbar-urile “ingramadite” in spatiile laterale ale zonei grafice de lucru poate fi usor identificate cautand icoana

marcata cu doua sageti ca in poza de mai jos. Aceasta va fi prezenta doar in aceasta situatie. Tinand click stanga de la mouse

apasat aceste toolbar-uri pot fi mutate oriunde pe ecran. ATENTIE! Aceste detalii referitoare la icoane “ingramadite” sunt valabile

pentru orice workbench din CATIA V5! RECOMANDARE! Nu lasati niciodata icoane “ingramadite” pe marginile zonei de lucru.

Incercati sa aranjati toolbar-urile astfel incat sa gasiti usor icoanele si sa va vina comod. O data aranjate icoanele isi vor pastra

pozitia (in general le gasiti “ingramadite” doar la prima deschidere a workbench-ului dupa instalarea programului).

Simbol ce indica faptul ca

sunt tollbar-uri “ingramadite”

Exemplu de aranjare a

icoanelor dupa ce au fost

mutate
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Exista posibilitatea ca unele toolbar-uri sa nu fie active. Pentru a le activa sau a cauta alte toolbar-uri puteti apasa click dreapta

de la mouse oriunde in zona gri de contur a zonei grafice de lucru. Aceasta actiune va deschide un meniu ce indica printr-o bifa

ce toolbar-uri din cadrul workbench-ului sunt active in zona grafica. De exemplu selectia toolbar-ului insert va duce la aparitia in

campul grafic a unui nou set de icoane. Optiunea Customize permite un nivel superior de modificare a interfetei grafice prin

modificarea optiunilor din meniul Start, adaugarea unor toolbar-uri suplimentare sau adaugarea de scurtaturi pe tastatura pentru

diverse comenzi.

Pentru deschiderea

meniului de toolbar-

uri se poate apasa

click dreapta mouse

oriunde pe zona gri

de contur

Optiunea

Customize
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6.2 Toolbar-uri de baza

Fly mode

DO NOT 

USE!

Fit All In

Face zoom si aduce 

modelul in centrul 

zonei grafice

Pan

Permite deplasarea 

modelului in zona 

grafica in plan

Zoom 

In

Zoom 

Out

Normal View

Orienteaza modelul 

in zona grafica 

perpendicular fata 

de o suprafata plana 

selectata

Create Multi-View

Imparte zona grafica 

in patru ferestre cu 

orientare 

perpendicular 

diferita in fiecare

Permite selectia 

unei vizualizari in 

zona grafica dupa 

diverse orientari

Hide/Show

Permite ascunderea 

sau afisarea oricarui 

lucru din zona grafica

Este util ca pentru anumite

tool-uri sa se implementeze

scurtaturi pe tastatura astfel

incat acestea sa fie accesate

usor. Tool-urile Hide/Show si

Normal View sunt doua astfel

de comenzi. Exemplul

prezentat arata definirea unei

scurtaturi pentru Hide/Show.

Rotate
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Swap Visible Space

Orice element ascuns trece intr-o 

zona care nu este vizibila. Aceasta 

functie permite trecerea intre spatiul 

elementelor vizibile si cel al 

elementelor ascunse

Measure Between

Permite masurarea distantei sau 

a unghiului dintre doua elemente

Measure Item

Permite masurarea 

unui element

Measure Inertia

Permite masurarea si 

calcularea proprietatilor 

unui volum

Manual Update Mode

Daca este activat 

atunci orice modificare 

a geometriei va 

necesita activarea 

manuala a update-ului

Update All

Permite Update-ul 

manual
Acest Toolbar are o serie de

functionalitati de baza. Permite

crearea unei piese noi, deschiderea

unei piese create, salvarea,

printarea, paste, undo, redo, help.

Toolbar ce permite schimbarea

culorii pentru volume sau suprafete.
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6.3 Utilizarea mouse-ului

Pentru a creste eficienta lucrului in CATIA V5 este important ca operatii precum Rotate, Zoom In, Zoom Out, Pan sa fie efectuate 

cu ajutorul mouse-ului. Acest lucru necesita insa putin exercitiu.

Prin apasarea si tinerea apasata a

butonului middle mouse si

deplasarea cursorului se efectueaza

comanda Pan

Prin apasarea si tinerea apasata a

butonului middle mouse si click

concomitent si deplasarea cursorului

se efectueaza comanda Rotate

Apasat si tinut Apasat si tinutApasat si tinut

Prin apasarea si tinerea apasata a

butonului middle mouse si apasarea

si eliberarea butonului click se

efectueaza comanda Zoom.

Miscarea mouse este doar inainte

(Zoom In) si inapoi (Zoom Out).

Apasat si tinut
Apasat si eliberat
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6.4 Tree-ul de lucru, plane de baza si compasul

Orice piesa nou creata (un fisier cu extensia .CATPart) contine predefinit o serie de

elemente: Numele fisierului, un sistem de referinta definit de trei plane perpendiculare intre

ele si un Body (un volum solid) denumit PartBody. Acestea sunt organizate sub forma unui

Tree (o structura de lucru tip arbore). Orice piesa (Part) contine un singur PartBody care

nu poate fi sters si asupra caruia nu pot fi aplicate functii booleene. In PartBody sau orice

alt body se vor regasi toate operatiile realizate in vederea modelarii unui volum solid.

ATENTIE! Este de evitat sa lucrati in PartBody. Daca s-a lucrat in PartBody este

recomandat sa creati un alt body pe care sa-l faceti PartBody (detalii asupra acestei

operatii vor fi date in alte cursuri). De asemenea este recomandat sa nu lucrati in planele

de referinta initiale ci sa creati un nou sistem de coordonate.

Nume Part

Plane de 

referinta

Body-ul 

initial

Parametri 

si functii

Prin apasarea click stanga mouse si tinerea

apasata pe linia alba a Tree-ului, acesta poate

fi deplasat oriunde in zona grafica de lucru.

ATENTIE! Prin executa unui click pe linia alba

a Tree-ului CATIA intra intr-un mod de

modificare al acestuia (se poate modifica

dimensiunea font-ului prin Zoom In, Zoom

Out). Puteti indentifica acest mod datorita

faptului ca elementele din zona grafica

devin gri. Ca sa iesiti din acest mod mai

executati un click pe linia alba a arborelui.

Compasul din zona grafica de lucru arata

orientarea modelului fata de sistemul principal

de coordonate. Acesta are si alte functionalitati

care vor fi prezentate pe parcursul acestui curs.
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1. Ce sunt Schitele (Sketches)?

Toate elementele constructive cu ajutorul carora se realizeaza piesele in CATIA (de altfel in mai toate programele CAD) sunt de

trei tipuri: elemente (features) bazate pe schite, elemente ce nu necesita schite si elemente derivate. In mod general toate

elementele de baza ce sunt realizate in CATIA se bazeaza pe o schita bidimensionala. In CATIA V5 schitele sunt facute in

workbench-ul Sketcher.

Modelul 3D al unei piese

Schita 2D pe baza careia 

s-a realizat piesa 

2. Alegerea suportului pentru o schita

Pentru a face o schita pot fi utilizate ca suport doar plane sau suprafete plane individuale ce apartin unor volume solide. Alegerea

suportului pe care se realizeaza schita se face in functie de orientarea piesei in raport cu sistemul de coordonate sau de locul

dintr-o piesa unde se doreste realizarea unui feature.
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3. Tipuri de Schite

Exista doua tipuri de schite: Sketch si Positioned Sketch.

Sageata prezenta in coltul din dreapta jos al icoanei arata ca toolbar-ul are si alte optiuni pe langa ce este

afisat.

Sketch Positioned 

Sketch

Optiunea Sketch permite crearea unei schite a carei orientare este dependenta de

sistemul global de coordonate si nu poate fi modificata. Orice schita, indiferent de

tip, are definit un sistem absolut de axe, AbsoluteAxis, ce este caracterizat de trei

elemente: HDirection (directie paralela cu axa orizonatala si simbolizata cu H),

VDirection (directie paralela cu axa verticala si simbolizata cu V) si Origin

(origine aflata la intersectie axei orizontale cu cea verticala). Optiunea Positioned

Sketch permite modificarea orientarii sistemului absolut de axe in raport cu

sistemul global de coordonate.
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4. Realizarea unei Schite
Pentru a creea o schita se selecteaza tool-ul Sketch si se da click pe unul din cele trei plane de baza, un alt plan definit, un plan

definit de un alt sistem de coordonate, pe fata plana a unui volum solid sau pe o suprafata plana individuala. Acest mod de

realizarea a unei schite nu depinde de tipul schitei utilizate (atat pentru Sketch cat si Positioned Sketch functioneaza la fel).

RECOMANDARE! E recomandat sa utilizati optiunea Positioned Sketch deoarece da un grad mai mare de control.

Dupa apasarea tool-ului

Sketch selectia planului pe

care se doreste realizarea

schitei se poate face dand

click pe un plan din zona

grafica de lucru sau pe un

plan din arbore (in exemplul

prezentat in poza este

selectat xy plane). Acest

lucru va duce la deschiderea

workbench-ului Sketcher si

orientarea vizualizarii din

zona grafica de lucru

perpendicular pe plan si in

accord cu directiile H si V.
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Automat prin creearea unei schite in body-ul PartBody din arbore se poate vedea ca a aparut un element nou numit Sketch.7 (7

fiind un numar ce este incrementat la fiecare schita nou creata in fisierul .CATPart in care se lucreaza). Modificarea numelui

schitei se face dand click dreapta pe numele acesteia->Properties->Feature Properties->Feature Name. Prin apasarea

butonului + in arbore se poate extinde structura arborescenta si observa proprietatile elementului creat (AbsoluteAxis, elemente

geometrice construite, constrangeri).

Origine HDirection

VDirection

Nume 

schita

AbsoluteAxis

Origine

HDirection

VDirection

Exit Workbench

Exit Workbench

Orientare perpendiculara 

pe planul xy

Prin apasarea butonului Exit

Workbench se va iesi din

workbench-ul Sketcher si se

va reveni in workbench-ul

Part Design. Daca nu a fost

construit nici un element

geometric in Sketcher atunci

schita creata va fi considerata

nula si va disparea din arbore.

ATENTIE! Daca se doreste

redeschirea schitei create se

va da dublu click pe numele

schitei in arbore sau pe schita

in zona grafica de lucru.
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Prin selectia Positioned Sketch va aparea o noua fereastra cu optiunile acestui tip de schita. In primul rand exista doua tipuri de

schita: Positioned (variant predefinita) si Sliding. Optiunea Sliding Sketch va avea ca rezultatul acelasi lucru ca o schita

normala, non-positioned (este complet echivalenta cu primul tip de schita creata). Aceasta optiune permite insa modificarea intre

o schita pozitionata si una nepozitionata. Optiunea Positioned permite modificarea originii si a orientarii cat si schimba H si V intre

ele sau a schimbarii sensului lor.

Fereastra pentru 

Positioned Sketch

Tipul schitei 

pozitionate

Planul de referinta 

al schitei

Schimbarea 

sensului H si V 

si a inversarii lor 

intre ele

Optiuni pentru 

schimbarea 

originii

Optiuni pentru 

schimbarea 

orientarii
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5. Tool-uri de vizualizare si selectie in workbench-ul Sketcher

Cut Part by Sketch Plane

Face o sectiune prin 

model folosing planul 

schitei

Setari de vizualizare a 

elementelor exterioare 

schitei (usual, low light, 

No 3D background)

Setari de referitoare la 

posibilitatea selectarii 

unor elemente din 

afara schitei

Diagnostics

Optiune care daca e 

activata coloreaza 

graphic elementele 

geometrice in functie de 

nivelul de constrangere

Dimensional 

Constraints

Afiseaza constrangerile 

dimensionale

Geometrical 

Constraints

Afiseaza 

constrangerile 

geometrice

Grid

Afiseaza o grila 

ajutatoare pe ecran

Snap to Point Construction/Standard Element

Permite constructia de elemente 

geometrice ajutatoare sau converteste 

elemente geometrice in elemente 

geometrice ajutatoare

Genereaza automat 

unele constrangeri 

geometrice cand 

este activat

Genereaza automat 

unele constrangeri 

dimensionale cand 

este activat



Harmonic Response

Proiectare in CATIA V5
Curs 1 – B. Realizarea schitelor

6. Tool-uri de constructie in workbench-ul Sketcher
ATENTIE! Pentru ca o schita sa poata fi folosita pentru constructia unui Feature (volum solid) este necesar ca profilul desenat sa

fie inchis. Doar in unele circumstante care vor fi prezentate se pot utiliza profile deschise. Utilizarea unui profil inchis intr-un alt

profil inchis va duce la indepartarea materialului definit de profilul inchis interior (acest lucru este valabil si in cazul definirii mai

multor profiluri inchis interioare).

Toolbar cu tool-

uri de constructie

Profile

Permite desenarea unui profil 

inchis selectand o succesiune 

de puncte. Prin selectia acestui 

tool se va deschide automat un 

nou toolbar ce permite selectia 

tipului de geometrie ce va fi 

desenata intre cele doua puncte 

(linie sau arc de cerc)

Axis

Toolbar cu tool-uri de constructie 

bazate in mare parte pe poligoane

Toolbar cu tool-uri de constructie 

bazate pe cercuri

Toolbar cu tool-uri de constructie 

bazate pe spline-uri

Toolbar pentru elipse, parabole si 

hiperbole

Toolbar cu tool-uri ce tin de drepte

Toolbar cu tool-uri ce tin de puncte
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Corner

Functia realizeaza o 

racordare intre doua 

drepte

Chamfer

Functia realizeaza 

un sanfren intre 

doua drepte

Toolbar utilizat pentru a 

ajusta, modifica sau 

completa diverse 

geometrii (Trim, Break, 

Quick Trim, Close arc, 

Complement)

Mirror, Symmetry, 

Translate, Rotate, 

Scale, Offset

Toolbar utilizat pentru realizarea 

proiectiilor

(Project 3D elements, Intersect 3D 

elements, Project 3D Silhoutte Edges, 

Project 3D Canonical Silhouette Edges)
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7. Cotarea si constrangerea schitelor
Constangerea schitelor este o etapa importanta pentru a asigura precizia dimensionala si geometrica a elementelor geometrice

cat si pozitia lor in raport cu alte elemente din afara schitei. Pentru anumite elemente generarea constrangerilor dimensionale si

geometrice este realizata in mod automat (ATENTIE! Acest lucru este valabil doar daca butonul de generare automata a

constrangerilor este activat, vezi pagina 27).

RECOMANDARE! Este recomandat sa nu incepeti niciodata schita din originea sistemului absolut de axe. Daca desenarea

oricarui element geometric este inceputa din origine atunci va exista o constrangerea de coincidenta a punctului plasat cu

originea care nu poate fi stearsa. Aceasta constrangere nu este simbolizata! Singura metoda de rupere a acestei coincidente

este de a sterge elementul geometric desenat si refacerea acestuia pornind din alt punct diferit de origine.

In momentul in care o constrangere este generata automat sau este impusa de utilizator un simbol va aparea in dreptul

elementului geometric desenat.

Simbol ce indica 

faptul ca dreapta 

este constransa pe 

directie orizontala 

fata de sistemul 

absolut de axe

Simbol ce indica 

faptul ca dreapta 

este constransa pe 

directie vertical fata 

de sistemul absolut 

de axe

Simbol ce indica 

o constrangere 

geometrica de 

tangenta

Simbol ce indica o 

constrangere 

geometrica de 

perpendicularitate

Simbol ce indica o 

constrangere 

dimensionala 

liniara

Simbol ce indica 

o constrangere 

dimensionala 

unghiulara

Simbol ce indica o 

constrangere 

dimensionala a 

unei raze

Simbol ce indica 

o constrangere 

geometrica de 

coincidenta
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Simbol ce indica 

o constrangere 

geometrica de 

concentricitate

Simbol ce indica o 

constrangere geometrica 

de coincidenta cu mijlocul 

segmentului de dreapta 

Simbol ce indica o 

constrangere 

dimensionala a 

unui diametru

Simbol ce indica 

o constrangere 

geometrica de 

paralelism

Linia intrerupta indica 

faptul ca a fost utilizat 

un element geometric 

ajutator

Constraint

Functie utilizata atat pentru 

realizarea constrangerilor 

dimensionale cat si a 

constrangerilor geometrice

Constrangerea dimensionala si geometrica a elementelor geometrice desenate

se face accesand functia Constraint si selectand pe rand elementele geometrice

asupra carora dorim sa aplicam o constrangere. In functie de conditiile

geometrice in care se afla elementele programul va face o sugestie de

constrangere (aceasta sugestie poate fi o dimensiune liniara sau unghiulara).

Daca se va selecta un singur element geometric (de exemplu un segment de

dreapta) programul va sugera lungimea acestora. Daca se vor selecta doua

elemente geometrice atunci programul va sugera distanta sau unghiul dintre ele.

Constrangerile ce sunt implementate pot fi observate si in arborele modelului.

Simbol ce indica 

o constrangere 

geometrica de 

simetrie
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a

b

c

ATENTIE! Pentru a stabili dimensiunea 38 mm din imaginea alaturata se pot utiliza

doua metode: utilizarea functiei Constraint selectand doar segmentul de dreapta a

sau selectand segmentele de dreapta b si c. La prima vedere cele doua optiuni sunt

echivalente si reprezinta acelasi lucru, insa nu este adevarat. Segmentul de dreapta

a este in realitate compus din trei elemente geometrice: doua puncte ce definesc

capetele segmentului si segmentul de dreapta in sine (acest lucru poate fi vizualizat

in arborele modelului). Prin selectia segmentului de dreapta a, dimensiunea 38 mm

reprezinta de fapt distanta dintre cele doua puncte ce definesc capetele segmentului.

Daca segmentele de dreapta b si c sunt sterse atunci segmentul de dreapta va

pastra constrangerea ce ii da dimensiunea de 38 mm. In cazul in care au fost

selectate segmentele b si c pentru definirea dimensiunii 38 atunci ea reprezinta de

fapt distanta dintre cele doua segmente de dreapta si are de fapt doar o legatura

indirecta cu segmentul de dreapta a. Daca segmentele b sau c sunt sterse atunci

constrangerea de 38 mm va fi si ea stearsa automat.

Pentru a modifica valoarea unei dimensiuni liniare sau unghiulare este necesar sa se

apese dublu click pe valoare si un meniu va fi deschis in care se poate modifica

valoarea. Prin bifarea optiunii Reference atunci dimensiunea va fi pusa intre

paranteze, iar campul Value nu va mai putea fi modificat. Dimensiunea va rezulta din

context.

Valoarea dimensiunii 

liniare (similar si pentru 

dimensiuni unghiulare)
Optiunea 

Reference
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Meniu accesat apasand

click dreapta mouse dupa

ce s-a facut selectia

elementelor geometrice in

cadrul functiei Constraint

Utilizand functia Constraint se pot aplica si constrangeri geometrice. Dupa selectia unuia sau mai multor elemente geometrice

daca se da click dreapta oriunde se va deschide un meniu ce va permite selectia altui tip de constrangere dimenionala sau a unui

tip de constrangere geometrica. RECOMANDARE! Este recomandat sa utilizati aceasta metoda pentru a aplica orice

constrangere geometrica.

O alta metoda de a aplica constrangeri dimensionale sau

geometrice este utilizarea functiei Constraints Defined in

Dialog Box. Aceasta optiune se activeaza dupa selectia unuia

sau mai multor elemente geometrice.

Constraints Defined 

in Dialog Box

Optiunile active in meniul Constraint

Definition sunt dependente de numarul

elementelor geometrice selectate cat si de

constrangerile geometrice deja existente

intre elemente.
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Stergerea unei constrangeri definita asupra unuia sau mai multor elemente geometrice se poate face in trei moduri diferite:

selectia cotei sau simbolului in zona grafica de lucru si apasarea tastei Delete, selectia elementului geometric si utilizarea functiei

Constraints Defined in Dialog Box si debifarea constrangerii sau stergerea constrangerii din arborele modelului.

Daca functia Diagnostics este activa (vezi pagina 27) atunci elementele geometrice desenate in zona grafica de lucru vor fi

automat colorate in functie de starea in care se afla in raport cu sistemul absolut de axe cat si precum grade de libertate posibile

intre elementele geometrice individuale. RECOMANDARE! Este recomandat ca o schita sa fie complet constransa dimensional

si geometric atat in raport cu sistemul absolut de axe cat si ca elemente geometrice individuale.

O schita complet 

constransa are 

elementele geometrice 

colorate in verde

O schita cu elemente 

geometrice colorate in 

culoarea magenta 

inseamna ca este 

supraconstransa

Daca exista elemente 

geometrice de culoare 

alba atunci schita nu 

este constransa
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TEMA: Sa se deseneze cele 4 schite pe baza desenelor primite. Acestea trebuie sa corespunda dimensional si sa fie complet

constranse.


